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Blok VII.5_Revit ile BIM MEP Modeline Giris

1. Amaglar

Ozellikle sihhi tesisat sisteminde bir BIM MEP modeli gelistirebilme.
Revit yazilimini kullanarak izometrik gériiniimler ve sayfalar olusturabilme.

BIM kullanarak bilgi iletme yetenegi.

2. Ogrenme metodolojisi

Ogretmen aracin kullanimi hakkinda bir agiklama yapacaktir.

Ogrenciler bu 6greticiyi okuyacak ve videolari izleyecek, alistirmayi yapacak ve MEP
araglarini ve ortamini kesfedecektir.

Gorevin basarisini degerlendirmek icin her 6grencinin Evsel Soguk Su sistemini ve levha
tasarimlarini olusturmasi gerekir.

3. Egitim siiresi
Bu 6greticide agiklanan gorev bir bilgisayar sinifinda gergeklestirilecektir.

6 ders saati stirecektir.

4. Gerekli 6gretim kaynaklari
internet erisimli bilgisayarlarin bulundugu bilgisayar odasi.
Gerekli yazilim: Revit.

Gerekli donanim: Yazilimi destekleyebilecek kapasiteye sahip bilgisayar.

5. icindekiler

5.1 Girig
5.2 Revit MEP Arayizi Erasmus+ Proje No: BIMVET3 2020-1-ES01-KA203-083262
Bu Erasmus+ Projesi Avrupa Komisyonu'nun destegiyle finanse edilmistir. Bu
5.3 Bir Projeye Ba§|amak yayin sadece yazarlarin goruslerini yansitmaktadir ve Avrupa Komisyonu ve
Erasmus+ Ulusal Ajanslari, burada yer alan bilgilerin herhangi bir sekilde
5.4 Bir Mimari Modeli Baélamak kullaniimasindan sorumlu tutulamaz.

5.5 Seviye Ekleme

5.6 Sihhi Tesisat Sistemleri
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5.6.1 Sihhi Tesisat Armaturleri

5.6.2 Evsel Soguk Su Sisteminin Olusturulmasi
5.6.3 Ek Agiklamalar

5.6.4 Cizelgeler Olusturun

5.6.5 izometrik Goriinimler Olusturun
5.6.6 E-Tablolar Olusturun

6. Teslim

Gorevin ylritilmesini gbsteren 3 sayfalik bir rapor.

7. Ogrendiklerimiz

Bir MEP projesinde bir mimari model nasil baglanir.
Sthhi tesisat armatdrleri nasil yerlestirilir.

Borular ve boru baglanti pargalari ile bir Evsel Soguk Su sistemi nasil olusturulur.

7. Bu egitimde kullanilacak dosyalar

Revit Architecture egitiminde .rvt formatinda olusturulan proje dosyasi.

5.1. Giris

Revit MEP, ayri ayri veya bir BIM projesinin pargasi olarak Mekanik, Elektrik ve Tesisat
olmak Ulzere ¢ mihendislik disiplininde calisan profesyoneller icin Autodesk Revit
yaziliminin bir pargasi veya islevidir. Mihendislik tasarim sirecini diizene sokmak icin
kullanilan, projelerin tasarimini ve gelistiriimesini daha verimli hale getirmek icin
kullanilan BIM modellerinin detaylandiriimasini saglayan bir dizi Revit aracidir.

Bu egitim, sihhi tesisat ve mekanik sistemlerin nasil boyutlandirilacagini 6gretmeyi
amaclamaz, bunun yerine, yaziimi kullanarak sistemleri modellemek icin Revit ana
araclarinin nasil kullanilacagini 6gretmeyi amaclar. Ulkeye gére degisen sistemleri
kurmak icin kurallari dikkate almayan sistemi kesfetmeye yonelik bir alistirmadir.

Bu egitimde, Revit kitapligindaki Temel Aileler kullanilacaktir. Ancak su anda sistem
bilesenleri (ireten bircok marka, projenin gercege en yakin olmasi icin piyasada
bulunan boyutlara, malzemelere ve diger parametrelere gore yapilandirilmis ailelerini
web sitelerinde indirmeye hazir hale getiriyor.
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5.2. Revit MEP Arayuzii

Revit MEP'in Revit'ten bagimsiz bir yazilim degil, onun bir bileseni oldugunu anlamak
onemlidir.

Revit Architecture egitiminde oldugu gibi, calisma ortamina ve navigasyon ve
diizenleme araglarina asina olmak zaten mimkindld. Asagidaki videoda, MEP
projelerinde 6zel kullanim igin bazi araglar gosterilecektir.

Flex A Fabrication PEID Modeser Mechancal  Pipe Pipe  Paralied Plumbing Sprinkier Cable Conduit Parallel i
Duct Terminal Part £quipment Placeholder Pipes Ry Fuaure . Tray Conduts Equipment > Foet

Fabrication * P&ID Collsbaration » Mechanical » Plumbing & Piping . Electrical

X > Man Bleanical Destribution L7 Typcal Room WSHP Typical Room WSHP > Typical Room WSHP. {o Tollet Room | Tollet Room & Main Bley

sz'Y\anT:pi | D D G D

— 1

B [log-s

5.3. Bir Projeye Baslamak

Programi actiktan sonra, Revit ana sayfasinda Yeni'ye tiklayin ve lzerinde calisilacak
proje sablonunu secmek icin Yeni Proje penceresi acilacaktir. Bu durumda, 6nceden
tanimlanmis bir Revit sablonu olan Metric-Systems kullanilacaktir.
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MODELS
MODELS
& Open..
™ New .. |
New Project w
FAMILIES
Template file
& Open.. T »
<None> l_]
Imperial-Construction Template
Y New ... c|Imperial-Architectural Template

Imperial-Structural Template
Imperial-Systems Template ate
Metric-Construction Template

Metric-Architectural Template
Metric-Structural Template Help
—

B Recent Files

B BIM360

Sample Architecture Proj... Sample Structure Project

Yeni Proje penceresinin seceneklerinde Metrik-Sistem Sablonu goriinmiyorsa, bu
sablonu yiklemek icin Gozat'a tiklayin. Sablon Se¢ penceresi acilacak ve ingilizce

klasériinde (Program Data/Autodesk/RVT 2022/Templates/English), “Systems-
Default_Metric” dosyasini secin ve ardindan ylklemek icin Ag'a tiklayin.
R Choose Template ? X

Look in: | English V| %= B X B vews ~
& Nome - Data de modificacdo | Freview
== [R) DefaultMetric 17/01/2020 15:40 ] '
@ DefaultUS-Canada 17/01/2020 15:40 !
. @ Electrical-Default_Metric 17/01/2020 15:39 ! . .
r% @ Electrical-DefaultGBRENU 19/01/2020 15:40 !
@ LT_USM_Default 17/01/2020 15:42 !
@ Mechanical-Default_Metric 17/01/2020 15:40 j .
- @ Mechanical-DefaultGBRENU 19/01/2020 15:40 !
My @ @ Plumbing-Default_Metric 17/01/2020 15:42 !
@ Plumbing-DefaultGBRENU 19/01/2020 15:40 !
@ Precast Detailing-DefaultMetric 17/01/2020 15:42 !
@ ResidentialGBRENU 19/01/2020 15:39 !
@ Structural Analysis-DefaultGBRENU 19/01/2020 15:40 !
@ Structural Analysis-DefaultMetric 17/01/2020 15:42 !
@ Structural Analysis-DefaultMetric-Up 17/01/2020 15:42 !
@ Structural Analysis-DefaultUS-Canada 17/01/2020 15:42 !
@ Systems-Default_Metric 17/01/2020 15:40 I
@ Systems-DefaultGBRENU 19/01/2020 15:40 !
@ UK Pipe Template 19/01/2020 15:40 I'wv
<
File name: | Systems-Default_Metric.rte v|
Files of type: |Template Files (*.rte) ~ |
Open | | Cancel |

Sablonu yikledikten sonra, Yeni Proje penceresinde segin ve Yeni Olustur'da Proje

secenegini segin.
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Mew Project *
Template file
Systems-Default_Metric.rte ~
Create new
(@) Project () Project template
oK Cancel Help

Sablon agildiktan sonra projede kullanilacak 6él¢u birimlerinin tanimlanmasi 6nemlidir.

Bunu yapmak icin, Yonet sekmesine tiklayin, Ayarlar paneli ve Proje Birimleri
secenegini segin.

L'J_ Project Parameters ﬁﬁ Transfer Project Standards

t@ Shared Parameters U_‘_rjr' Purge Unused

'f[ Global Parametersl Project Units

Settings

Ardindan, her parametre igin olcim birimlerinin gosterildigi bir pencere acilacaktir.
Metre olarak degistirilecek Uzunlugu iki ondalik basamakla degistirecegiz ve Egim
parametresini de Ylizde olarak degistirecegiz. Alanlar, hacimler ve agilar igin Yuvarlama
seceneginde iki ondalik basamak da tanimlanmahdir.

Project Units X
DISCIFI“I"IE: Common L
Units Format 2
Angle 12.35°
Area 1234.57 m?
Length| 1234.57 m
Mass Density 1234.57 kg/m?
Slope | 1235%
Speed 1234.6 km/h
Time 12346 s
Volume | 123457 m*
Currency 1234.57
w

Decimal symbol/digit grouping:
123,456,789.00 W
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Format *

Use project settings

Units: Meters b
Rounding:

2 decimal places ~ || 0,01

Unit symbaol:

m k¥4

] suppress trailing 0's
Suppress 0 feet
Show + for positive values
[ Juse digit grouping

Suppress spaces

5.4. Bir Mimari Modeli Baglamak

MEP projeleri genellikle baglantili mimari modeller kullanilarak olusturulur. Baglanti,
mimari ve MEP disiplinleri arasinda isbirligine dayali ve koordineli bir sekilde ¢alismayi
saglar. Projedeki baglantii model degistirilirse, Revit proje her agildiginda modeli
otomatik olarak glincelleyecektir.

Bu egitimde, daha 6nce Revit Architecture egitiminde olusturulmus olan mimari modeli
baglayacaksiniz. Baglanti kurmak icin Ekle sekmesine erisin ve Baglanti Revit simgesine

tiklayin.
Rec) R &
WF

Link | Link Link Link D
Revit| IFC CAD Topography Markup

Ardindan, ice aktarilacak dosyayl se¢mek igin bir pencere agilir. Revit Architecture
egitiminde olusturulan proje dosyasina goz atin ve arayin, ardindan dosyayi segin.
Konumlandirma icin istediginiz secenegi belirleyin, cogu durumda “Otomatik — Dahili
Baslangic Noktasindan Dahili Baslangic Noktasina” secenegini secmelisiniz. Ac'a
tiklayin.
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R Import/Link RVT

v|* L X B views -

Look in: | [ Area de Trabalho
Preview

MNome
@ OneDrive - Personal

History 2
Fﬁ W Este Computador @

‘1 Bibliotecas
Documents ¥ Rede

==

My Computer

ol
E Architecture I

-

My Netwo...

Favorites

File name: |

Files of type: |RVT Files (%.rvt)

Positioning: |Auto - Internal Origin to Internal Origin

| Open | IEI | Cancel

Baglantil model daha sonra Cizim Alaninda gorintiilenecektir.

Fare imleci mimari model Baglanti giziminin Uzerinden gectiginde mavi bir segim
kutusu belirir. Bazen bu mavi gizgiler tasarim gorsellestirmesinin éniine geger.
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Baglanti modellerin seg¢imini devre disi birakmak igin, Secim Kutusunun artik
goriinmemesi icin Secim Gegisleri cubugundaki Baglantilari Se¢ simgesine tiklamaniz
gerekir.

el & OF M & Yo

5.5. Kat Seviyesi Ekleme

Onceden tanimlanmis sablon (Systems-Default_Metric) sadece 2 seviye (Seviye 1 ve
Seviye 2) saglar ve her projenin ihtiyaclarina gére daha fazlasini olusturmak gerekebilir.

Proje Tarayicisindan Kotlar goriinimlerinden birini acarken sablon katlarini gérmek
mimkindir ve ayrica alinan modelin (Bodrum, Zemin Kat ve Cati) seviyeleri de
gorilebilir.

Baglanti mimari modelin seviyeleri sadece bir grafik temsilidir ve mevcut projede
referans olarak kullanilamaz. Baglantili modelin tiim unsurlari tek bir bloktadir, bu da
degistirilmesini imkansiz kilar, bu nedenle mevcut projeye mimari modelinkilerle
ortlisen seviyeler eklemek gerekir.
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Roof g~
R e

Level 2 G
400m *

Ground Floor

A
2.60m N

Level 1 \ Basement "‘
0.00m E 0.00m

Kat 1 ve Kat 2'nin sirasiyla “Bodrum” ve “Zemin Kat” olarak yeniden adlandiriimasi ve
yuksekliklerinin, ithal edilen tasarimin (0,00 m ve 2,60 m) seviyeleri izerinde olacak
sekilde degistirilmesi onerilir. 6.00 m yiiksekliginde lglincl bir seviye olusturulmali ve
“Cat1” olarak adlandiriimalidir.

Bu yeni seviyeyi olusturmak igin, Cat: icin, Mimari sekmesinde, Datum panelinde,
Seviye'ye tiklayin.

& Level
oFF Grid

Datum

Fare imlecini Zemin Kat seviyesinden yaklastirdiginizda, Zemin Kat seviyesine gore
gecici bir boyut goriinecektir ve bu, eklenecek seviyenin bir 6nizlemesi olarak hizmet
eder. Fare hareketine bagli olarak boyut degisir.

o ___ Ground Floor ﬂ
260m -

Basement ﬁ\
0.00m °

Zemin kata gore yeni kat 3.40 m olacaktir. 3.40 m'lik gecici boyutu gorintiiledikten
sonra, ¢izim alanina tiklamaniz yeterlidir ve yeni seviye eklenecektir.
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. . - . Roof G
6.00m

- = — _Ground Floor G
260m

Basement s
0.00 m

Bir binadaki her kat icin bir seviye olusturmaya ek olarak, esik seviyesi gibi referans
seviyeleri de olusturabilirsiniz.

5.6. Sihhi Tesisat Sistemleri

Evsel su sistemi su sistemlere ayrilmistir: Soguk Su, Sicak Su ve Sihhi. Bu egitimde, bir
Evsel Soguk Su sistemi olusturma ornegi gosterilecektir.

5.6.1. Sihhi Tesisat Armatiirleri

Bir sistem olusturmaya baslamadan 6nce, lavabo, klozet, kivet vb. sihhi tesisat
armatdurlerini yerlestirmek gerekir. Bu elemanlar Mimari modele zaten eklenmis olsa
da, mimari Revit baglantisi Gizerinden eklendiginde, tiim elemanlari tek bir bloktadir ve
bu da degistiriimesini imkansiz hale getirir. Bu nedenle sihhi tesisat projesinde aileyi
mimari aile ile ortiisecek sekilde yeniden yerlestirmek gerekir.

Bu nedenle, Proje Tarayicisinda, Bodrum tesisine karsilik gelen “1- Tesisat”
gorinimiini acin (gerekirse yeniden adlandirmak mimkindir). (image) Sistemler
sekmesinde, Tesisat ve Borular panelinde, Tesisat Fikstlir simgesine tiklayin.

Project Browser - Projeto MEP X
=0, Views (Discipline)
Electrical
Mechanical
= Plumbing
777
HVAC
= Plumbing
[=}-- Floor Plans
1 - Plumbing
2 - Plumbing
3D Views
Elevations (Building Elevation)
:" Legends
™ Schedules/Quantities (all)
Sheets (all)
91 Families
[@ Groups
&3 Revit Links
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Sistemler sekmesindeki Sihhi Tesisat ve Borular panelinde Sihhi Tesisat Fikstiri
simgesine tiklayin.

S & =2

Pipe Pipe Parallel ﬁ
Placeholder Pipes 'IQ

Plumbing & Piping bl

Plumbing prinkler
Fixture v

Ozellikler Paletinde, Revit tarafindan secilen herhangi bir cihaz gériinecektir. Secilen
ekipmani degistirmek icin 6genin resmine/agiklamasina tiklamaniz yeterlidir.

Properties X
. M_Sink - Island - Single .
455 mmz455 mm - Public
New Plumbing Fixtures ~ | c@ Edit Type
Constraints A oA
Schedule Level Level 1
Elevation from Level 0.0
Host <not associated >
Plumbing B
Flow Pressure 551 58.000000 Pa
Mechanical
System Classification Domestic Cold Water,Do...
System Type Undefined

System Name

System Abbreviation

Identity Data el .,
Properties help Apply

Ardindan, birkag Revit ekipmani ailesinin bir listesinin goriindlgu Tip Secici acilacaktir.
Mevcut tim pargalari gormek i¢in kaydirma ¢ubugunu kullanin.

M_Sink - Island - Single
455 mmx455 mm - Public
feorc

| £3U 1NN SUGINET - U NI Uiain

250 mm Strainer - 80 mm Drain

250 mm Strainer - 100 mm Drain
. M_Sink - Island - Single

455 mmx455 mm - Private

[ 455 mmuass mm - Public

@ M_sink - Kitchen - Double

1065 mmx535 mm - Private

1065 mmx535 mm - Public

&P _sink - Mop

710 mmx710 mm

‘ M_Urinal - Wall Hung

20 mm Flush Valve

25 mm Flush Valve

Q M_Water Closet - Flush Valve - Wall Mounted
Private - 6.1 Lpf
Private - Flushing Greater than 6.1 Lpf

Public - 6.1 Lpf
Public - Flushing Greater than 6.1 Lpf
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Bu ornekte, yeni aileler yiikleneceginden, Tir Segici listesinde baslangicta goriinen
cihazlarin higbiri kullanilmayacaktir. Bunun igin Sistemler sekmesi ve Sihhi Tesisat
Fikstir ikonu tiklandiktan sonra Modify |Place Sihhi Tesisat Fikstlr sekmesi agilacaktir
ve bu nedenle Load Family'ye tiklayiniz.

Manage Add-ins Modify | Place Plumbing Fixture

BE & © ©

Load | Model |Place on| Place on Tag on
Family [In-place | Face |WorkPlane Placement

Mode Placement Tag

Asagidaki  yola erisilmesi gereken Load Family penceresi acilacaktir:
ProgramData/Autodesk/RVT 2022/Libraries/English/Plumbing/MEP/Fixtures. Fiksturler
klasoruniin icinde, ekipman tipine gore isimlendirilmis birkag klasor vardir. Su Dolaplari
klasorini agin.

R Load Family ? X
el Fixtures v | E_"“ ] Views -
) Preview
Nome Tipo
Water Closets
Urinals
Sinks

Showers

Lavataries
Emergency Fixtures
% Drinking Fountains
Drains

Connectors
Bathtubs
Appliances

My Computer

File name: ~

Files of type: |All Supported Files (*.rfa, *.adsk) ~

Open Cancel

Su Klozetleri klasorinl acarken, bu siniflandirmanin bazi element aileleri belirir. CTRL
tusuna basarak “M_Water Closet — Flush Tank” ve “M_Bidet” ailelerini secin ve projeye
ylklemek icin Open'a tiklayin.
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R Load Family ? x

Look in: Water Closets v | A EJ'A X r':_"_ Views
Preview

MNome Tipo

M_Water Closet - Quiet Flush Tank

M_Water Closet - Flush Valve - Wall Mounted

M_Water Closet - Flush Valve - Floor Mounted

M Water Closet - Flush Tank

M_Bidet

My Computer
£

File name: | M_Water Closet - Flush Tank.rfa w

Files of type: |All Supported Files (*.rfa, *.adsk) v

Open Cancel

Asagidaki aileleri yiklemek icin ayni islemi tekrarlayin:

e |avabolar:

o M_Sink—is
o M_Sink —Servis
e Duslar:

o M_Dus Kabini — Dikdortgen

Not: Ozellikler Paletinde 6geyi cogaltin ve asagidaki boyutlara sahip 4 yeni 6ge
olusturun:

e 1.60mx1.00 m
e 130mx1.30m
e 1.45mx0.90m
e 1.20mx0.90m
e tuvaletler:
o M_Lavatory — Dikdortgen
o Kivetler:
o M_Banyo Klveti — Maestro

Not: Ozellikler Paletinde, Diizenleme Tiirii'ne tiklayin ve Kiivet Genisligi parametrelerini
1,10 m ve Klivet Uzunlugu parametrelerini 2,50 m olarak degistirin.

o Aletler:
o M_Camasir Makinesi
o M_Bulagik makinesi

Tum aileleri yikledikten sonra bu o6geleri gorinime ekleyebilirsiniz. Sistemler
sekmesindeki Sihhi Tesisat ve Borular panelinde Sihhi Tesisat Fikstirli simgesine
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tiklayin. Simdi Ozellikler Paletinde, Tiir Segici'de yiiklenen tim aileler goriiniir.
“M_Water Kapali — Flush Tank” ailesinden “Private — 6.1 Lpf” tipini seginiz.

Properties X [ 2-Plumbing X |
M_Water Closet - Flush Tank J B@
Private - 6.1 Lpf
l‘iearfh P
25 mm Flush Valve ~
' M_Water Closet - Flush Tank
| Private - 6.1 Lpf
Private - Flushing Greater than 6.1 Lpf M_Water Closet - Flush Tank
Public - 6.1 Lpf

Public - Flushing Greater than 6.1 Lpf
Q M_Water Closet - Flush Valve - Wall Mounted

Private - 6.1 Lpf

Private - Flushing Greater than 6.1 Lpf
Public - 6.1 Lpf
Public - Flushing Greater than 6.1 Lpf

. M_Whirlpool Spa
W

Most Recently Used Types

Oge seciliyken, imleci eklemek istediginiz yere getirin. Nesneyi déndirmek icin
klavyedeki bosluk cubugunu kullanabilirsiniz. Nesne konumlandirildiginda, eklemek igin
¢izime tiklamaniz yeterlidir.
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Takilan ekipmana tiklandiginda, Ozellikler Paleti nesneyi tanimlar ve her projeye gore
ozellestirilmis degisiklikler yapilabilir. Nesnenin yaninda su giris ve ¢ikis baglantilarinin
tanimlamalari gérindr.

3.00FU/]Y /

Out

80.0 mm

e

Diger tim 6geleri agsagidaki dagitimla ekleyin:
Manzara: 1- Sihhi Tesisat (Bodrum kat):

Tuvalet 1:

e M_Water Klozet — Yikama Tanki — Ozel 6.1 Lpf
e M _Lavatory — Dikdértgen — Ozel — 560 mmx560 mm
e M_Dus Kabini— Dikdértgen — 1,60 mx 1,00 m — Ozel

Tuvalet 2:

e M_Water Klozet — Yikama Tanki — Ozel 6.1 Lpf
e M _Lavatory — Dikdortgen — Ozel — 560 mm x 560 mm
e M_Dus Kabini — Dikdértgen — 1,45 mx 0,90 m — Ozel
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WcC1

Q@

Manzara: 2 — Sihhi Tesisat (Zemin Kat)

Banyo 1:

o M_Water Klozet — Yikama Tanki — Ozel 6.1 Lpf

o M_Bidet

o M_Bath Kiivet — Maestro — Ozel

o M_Lavatory — Dikdértgen — Ozel — 560 mm x 560 mm

o M_Dus Kabini — Dikdértgen — 1,30 mx 1,30 m — Ozel
Banyo 2:

o M_Water Klozet — Yikama Tanki — Ozel 6.1 Lpf

o M_Lavatory — Dikdértgen — Ozel — 560 mm x 560 mm

o M_Dus Kabini — Dikdértgen — 1,60 mx 1,00 m — Ozel
Banyo 3:

o M_Water Klozet — Yikama Tanki — Ozel 6.1 Lpf

o M_Llavatory — Dikdértgen — Ozel — 560 mm x 560 mm

o M_Dus Kabini — Dikdértgen — 1,20 mx 0,90 m — Ozel
Mutfak:

o M_Sink—is

o M_Bulagik makinesi
WC:

o M_Water Klozet — Yikama Tanki — Ozel 6.1 Lpf

o M_Llavatory — Dikdértgen — Ozel — 560 mm x 560 mm
Camasir odasi:

o M_Sink —Servis
Depolamak:

o M_CGamasir Makinesi
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[ ] STORAGE

BEE | LAUNDRY
Wi @iffj room

KITCHEN

BATHROOM

o3 .
ic] B
=] a/mmgm
2
@ BATHROOM
o 1 =4

Not: “M_Sink — Work” elemani icin zemine gére kotu diizenlemek gereklidir. Bunun
icin elemani seginiz ve Ozellikler Paleti'nde kottan yiikseklik alanina 0.80 m degerini
giriniz.

5.6.2. Evsel Soguk Su Sisteminin Olusturulmasi

Tim armatirler vyerlestirildikten sonra Evsel Soguk Su dizenini olusturmaya
baslayabilirsiniz. Bunu yapmak icin, takili sihhi tesisat armatirlerinden birine ve
ardindan Degistir sekmesindeki Boru simgesine tiklayin.

Modify | Plumbing Fixtures

= [

Connect Piping
into

1 lLayout Create Systems

Sistem tipinde Kullanim Soguk Su seceneginin secilmesi gereken Boru Sistemi Olustur
penceresi gorunecektir. Sistem adi alaninda sistem adi degistirilebilir (bu durumda
tutulacaktir) ve Sistem Dizenleyicisini A¢ secenegi isaretlenmelidir. Bu ayarlardan
sonra Tamam'a tiklayin.

Create Piping System ? X
System type: Domestic Cold Water w
System name: | Domestic Cold Water 1

[~] Open in System Editor
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Sisteme baska fikstlrler eklemek icin Sisteme Ekle aracini secin.

k| B ke & ¢

Modify |Properties

Remove Select Finish Cancel
to Systemfffrom System = Equipment Editing System Editing System

Select » Properties Edit Piping System Mode

FDimin A Suctar

Fare imlecini yaklastirin ve Bodrum ve Zemin Kattaki tim armatdrlere tiklayin.

v .

Tum cihazlari segtikten sonra Finish Edit System se¢enegine tiklayin

Borulari tasarlamanin iki yolu vardir: manuel olarak veya Revit tarafindan olusturulan
ve yerlestirildikten sonra degistirilebilen otomatik céztiimler araciligiyla.

Otomatik olarak olusturmak icin, sisteme eklenen 6gelerden birine tiklayin ve Degistir |
Tesisat Armatiirleri, Diizen Olustur simgesine tiklayin.

Modify | Plumbing Fixtures = Piping Systems

L ‘s

Generate] Generate Connect Piping
Layout JPlaceholder Into

1 Layout Create Systems

Revit daha sonra sisteme eklenen elemanlari okuyacak ve bu elemanlarin dizilisinden
¢ozumler Uretecektir. Bazi diizenleme araglarinin goriindigu Dizen Olustur sekmesi
acilacaktir.
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EL/,? E G' E 6 Slope Value: Qf %

Edit |Solutions Remove Place 0.0000% *  Finish Cancel
Layout from System Base Layout Layout
Madify Layout Slope Generate Layout
Generate Layout Solution Type  Network w 2of2 4l e Settings ...

Generate Layout (Layout Olustur) c¢ubugunda, Cozim Tipi'nde, tasarimcinin
tercihlerine gore Ag, Cevre veya Kavsak olabilen ¢oziim tipini segmek mimkiindir. Bu
ornekte, Ag secenegi korunacaktir. Coziim tliriinlin yaninda Revit tarafindan Uretilen
¢Ozlimlerin sayisi yer alir. Bu durumda, iki tane Uretildi.

Generate Layout Solution Type  Network v 20f2 4 I Settings ...

Tasarim modeli genellikle borularin yiksekliklerini ve tiplerini ve ¢aplarini belirler.
Ancak, sistem borulari i¢in boru tiplerini ve standart yukseklikleri belirtmek gerekli
olabilir.

Ayarlar'a tiklamak Boru Donustlirme Ayarlari penceresini agar. Ana maddede, Boru Tipi
parametresinde “PVC — DWV” malzemesini secin ve Offset'te borularin levhanin
altindan ge¢mesi icin -0.20m degerini tanimlayin. Branch 6gesi i¢in de ayni degisiklikleri

yapin.

Main |
Branch System Type: Domestic Cold Water
Setting Value
Pipe Type Pipe Types: PVC - DWV
Offset -0.2000 m
OK Cancel

Revit tarafindan Uretilen ¢oziimlerden biri asagidaki resimde gosterilen ¢ozimdi (Ag
tipinin 1/2 C6zumi). Ancak bu ideal bir ¢6zim degildir ve bazi ayarlamalar yapilmasi
gerekmektedir. Yazihm tarafindan otomatik olarak olusturulan bir ¢6zim oldugu icin
bir bilgisayardan digerine farkhliklar ve hatta daha fazla ¢6ziim olabilir.
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Lt

Remove
from System

Modify Layout

Bu arac ile sisteme eklenen borulari stirikleyip yeniden konumlandirmak mimkinddr.
Bu durumda, Dizen diizenleme disinda manuel olarak da ayarlamalar
yapilabileceginden hicbir diizenleme yapilmayacaktir.

Borularin ve baglantilarin caplari da daha sonra degistirilecektir. Tanim olarak, timi 15
mm capindadir.

Tamamlamak icin Diizeni Bitir'e tiklayin.

v X

Finish Cancel
Layout Layout

Generate Layout

Sonunda, biri asagidaki resimde gosterildigi gibi acik birakilmis bir baglantidan
kaynaklanabilecek bazi hatalar gérinebilir.

This element has an open connection. This may not be an error, but for flow
calculations to work correctly all connections should be sealed with an end cap.

Am*q
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Yukaridaki hata, aksesuar yerlestirmek icin yer olmamasi nedeniyle baska bir hatayla
ilgili olabilir.
‘I.T*.l'arning:SZn_J;oftl -

There was not enough room to place the required fittings. Consider increasing
the length of the segments, or moving them farther apart to generate a solution.

-
D

g

Hata pencereleri gosterilirken, kontrol etmeniz igin 6ge ¢izimde vurgulanir. Simdi
devam etmelisiniz, ¢linki hatalar daha sonra dizeltilecektir.

Proje Tarayicisini kullanarak, Zemin Kat'a karsilik gelen “2-Sihhi Tesisat” kat planina
erisin. Sistem bu katin désemesinin -0.20m altina yerlestirildigi icin bu goériinimde
gériinmeyecektir. Goriiniir hale getirmek igin Ozellikler Paletinde, Gériinim Aralig
parametresinde Diizenle'ye tiklayin.

Properties
E}ﬁ Floor Plan v

Floor Plan: 2 - Plumbing v Edit Type

Sun Path 1l LA
Underlay 3

Range: Base Level Basement

Range: Top Level Unbounded

Underlay Orientation Look down

Extents 2

Crop View ]

Crop Region Visible ]

Annotation Crop ]
| View Ranc.;e Edit...

Associated Leve Ground Floor

Scope Box None

Depth Clipping No clip

Identity Data 2 v
Properties help Apply

Ardindan Goriinim Araligi penceresi acilacaktir. Gorliinim Derinligi'nde, Diizey
parametresini “Sinirsiz” olarak degistirin ve ardindan Tamam'a tiklayin.
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View Range

Primary Range

III X

Top: Associated Level (Ground F ~ Offset: | 4.0000 m

Cut plane: Associated Level (Ground F Offset: | 1.2000 m

Bottom: Associated Level (Ground F ~ Offset: | 0.0000 m
View Depth

Level: Unlimited w Offset: | 0.0000 m

Learn more about view range

<< Show 0K Apply Cancel

Bu nedenle bu kattan bakildiginda tim sistem gorilebilir.

Elemanlarin gorsellestirilmesini iyilestirmeye yardimci olan 6nemli bir ipucu, kontur
cizgilerinin kalinhigini azaltmaktir. Bunu yapmak igin Hizli Erisim Ara¢ Cubugunda
bulunan ince Cizgiler aracina tiklayin.

REGHG &-2-8 2-F0A 6 -o[FE]xa-+

Grafik gorsellestirmede yardimci olabilecek baska bir ipucu, Ayrinti Dizeyi'ni lyi
segenegine ve Gorsel Stili Gergekgi veya Tutarli Renk olarak ayarlamaktir.

Elakx @& o afla <
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Revit tarafindan otomatik olarak olusturulan ag diizeninden, boru hatlarinin optimize
edilmesi i¢in daha iyi uyarlamak igin manuel dizenlemeler yapilacaktir. Bu hidrolik
sistem igin tek bir tasarim ¢6zimu yoktur, bu nedenle ag dizeni is tercihlerine gore
degisir.

Aciklayici bir 6rnek olarak, asagidaki resimde gosterilen sistem bolgesi diizenlenecektir.
Diger bolgelerin takibinin de tercihlere gore diizenlenmesi 6nerilmektedir.

M
(niin]
T

Sistem ayarlarinizin daha kolay goriilmesini saglamak icin Proje G6zatma'da cephe
gorinlimleri agabilir ve Hizli Erisim Ara¢ Cubugundaki Kesitler aracini kullanarak kesit
gorinimleri olusturabilirsiniz.

Baslangi¢c olarak, asagidaki resimde gosterildigi gibi Banyo 1'de Bide ve Su klozet
baglantilari hari¢ tutulacaktir. Bir elemani silmek igin Uzerine tiklayin ve sil tusuna
basin. Tim baglantilarin silindigini 3B gériiniimde kontrol edin.

E

AgI manuel olarak izlemeye baslamak icin, 6gelerden birini secin ve ekipmanin

“Giris” simgesine tiklayin.
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15.0 mm

1.50 RU

Ardindan, fare imlecinin hareketine gore hareket eden boru yolunu temsil eden bir
¢cizgi gorunir. Gegici boyuta dikkat edin ve duvara 0,10 m yerlestirin.

Sistemler sekmesindeki Sithhi Tesisat ve Borular panelinde Boru aracini segin.

o & ER L XK

Pipe Pipe Parallel @ Plumbing Sprinkler
Placeholder Pipes % Fixture

Plumbing & Piping -

Ozellikler Paletinde “PVC — DWV” boru tipinin secildigini dogrulayin.
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Properties X
Pipe Types -
PVC - DWV
Pipes (1) v | 8 Edit Type
Constraints A oA
Horizontal Justification  |Center
Vertical Justification Middle
Reference Level Basement
Top Elevation 24107 m
Middle Elevation 24000 m
Bottom Elevation 23893 m

Start Middle Elevation 124000 m
End Middle Elevation 24000 m

Slope 0.0000%
Dimensions %
QOutside Diameter 21.3 mm
Inside Diameter 15.8 mm
Size 15 mmg b
Properties help Apply

Secenekler cubugunda 15 mm capin segili olup olmadigini kontrol edin.

Modify | Pipes Diameter: | 15.0 mm w

Bununla, fare imlecini halihazirda eklenmis olan baglantilardan birinin sonuna
yaklastirin ve iki nesneyi birbirine baglamak icin digerine strikleyin.

foint. 1I5SmMm@026m

Klozetin altina giren boru da silinecek ve diger ucundaki boru ile ayni hizaya gelecek
sekilde Boru araci ile yenisi cizilecektir.
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Yenisini olusturmadan dnce boruyu segmeli ve silmelisiniz.

-0.2000 m

#

3D goérunimden Visual Style in Realistic segenegi ile mouse diger uca yaklasildiginda
bazi baglantilarin Ug cikigla kaldigi fark ediliyor.

\\Qj::::;:
Cikislardan birini kaldirmak icin baglantiya ve ardindan simgesine tiklamaniz yeterlidir

— . Bu durumda, kisa, diiz bir baglanti oldugu icin baglanti tamamen kaldirilacaktir.

§\ /: J

O N

15.0 mm

15.0 mm

15.0 mm{}

Ayrica yeni boruyu klozete baglayacak baglanti gibi bazi baglantilarda bir cikis daha
eklemek gerekebilir. Bunu yapmak icin *, istediginiz yondeki simgeye tiklayin.
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15.0 mm

15.0 mm

Sistemler sekmesinde, Boru aracini segin ve baglanti icin olusturulan yeni ciktiya
tiklayin. Secenekler Cubugunda, Orta irtifa'da -0.20 degerini girin.

Middle Elevation: | -0.2000 m ~| 2T | Apply

Boruyu baglanti cikisindan tuvalet baglantisinin duvarina asagidaki resimlerde
gosterildigi gibi stirtikleyin.

§
o 1 !

| Horizontal and Extension ]

Borulari hizalamak igin bunlardan birini secgin ve Degistir | Borular, Tasima aracini seger
h.N

* . Yeni borunun ortasindaki noktayi ve ardindan tuvalet borusunun orta noktasini
segin.
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Endpoint

1951 m

Ardindan baglantiyi secmeli ve sil tusuna basmalisiniz.

Borulari birlestirmek icin Revit'te bu islemleri gerceklestirmek i¢in ¢cok kullanisgl bir arag

=
olan Koseye Kirp/Uzat araci kullanilacaktir ;ﬁh. Bu alet, borularin baglanmasi
gerektiginde kullanilabilir. Bunu yapmak i¢in borulardan birini se¢melisiniz ve Degistir |
Boru, Kirp/Koseye Uzat aracini segin.

e 00 =
¢3¢ O 212 %

Modify
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Arag seciliyken, iki boruya tiklamaniz yeterlidir, baglanti otomatik olarak eklenecektir.

Lavabo gibi diger ekipmanlar da daha optimize bir sekilde baglanacak. Bu tip
lavabolarin soguk su girisi icin capi 25 mm'dir. Bu 8lgiimii, 6geye tiklayarak ve Ozellikler
Paletinde Diizenleme Turi'ne tiklayarak degistirmelisiniz.

Properties X

M_Lavatory - Rectangular
560 mmx560 mm - Private

Plumbing Fixtures (1) v | Edit Type
Constraints Gl A~

Schedule Level Ground Floor

Elevation from Level 0.8650 m

Host Linked Revit Model : Praj...
Plumbing R

Flow Pressure 55158.000000 Pa h
Mechanical B
System Classification Domestic Cold Water,Do...
System Type Domestic Cold Water
System Mame Domestic Cold Water
System Abbreviation

Identity Data A
Image

Comments v
Properties help Apply

Tip Ozellikleri penceresi agilacak ve Soguk Su Capi parametresi 15 mm olarak
degistirilmelidir.
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Type Properties X

Family: | M_Lavatory - Rectangular ~ | Load...
Type: |550 mmx560 mm - Private b= | Duplicate...

Rename...

Type Parameters

| Parameter | Value | :| C

Default Elevation 0.8650 m

Sink Material <By Category=

Faucet Material <By Category> :
Sanitary Radius 16.0 mm [l
Sanitary Diameter 32.0 mm ]
Sink Width 03810 m |
Sink Length 03050 m ||
Lavatory Length 0.5600 m ||
Lavatory Width 0.5600 m ]
Hot Water Radius 7.5 mm | ]
Hot Water Diameter 15.0 mm | ]
Cold Water Radius 7.5 mm | ]
Cold Water Diameter 15.0 mm | ]

<

What do these properties do?

o
=

<< Preview

[ e |

Bide ve klozet ile ayni sekilde, borulari optimize etmek igin iki lavabo baglanacaktir.
Y

Daha sonra lavabo baglantilari ¢cikarilmal ve ardindan
araci ile yeni baglantilar olusturulmahdir.

ekipman Uzerindeki “In”

Yukarida belirtilen araglari kullanarak dus, kiivet, lavabo, bide ve tuvaleti asagidaki
resimlerdeki gibi bir konfiglirasyonda baglayin.
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Sistemin diger bolimlerinde de benzer degisikliklerin yapilmasi tavsiye edilir, boylece
daha iyi dagitilmasi igin daha iyi ¢gdziimler olusturulur.

Sistem ayarlarini tasarlamaya yardimci olmak igin Proje Go6zatma'da cephe

goéruntmlerini (Yukseklikler) acabilir > ve Hizli Erisim Ara¢ Cubugundaki Kesitler
aracini kullanarak kesit goértinimleri olusturabilirsiniz.

Olasi ¢coziimlerden biri asagidaki resimlere benzeyebilir.

149



Co-funded by the R
Erasmus+ Programme x  *
of the European Union

3B BIM Modelleme

Halihazirda projede yapilandirilan Evsel Soguk Su sistemi ile sistemi umumi sebekenin
noktasina baglamak icin bir boru cekilmelidir. Bu projede, genel ag noktasinin konumu
gosterilmemistir, bu nedenle bir tahmin yapilacaktir.

Sebeke baglanti borusunun sisteme baglanacagl nokta asagidaki resimde Kirmizi ile
daire icine alinmistir.
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Kamu agini baglayan bolimi tasarlamaya baslamak icin, Zemin Kat'a karsilik gelen “2 —
Sihhi Tesisat” gorinimini agin.

Sistemler sekmesindeki Sithhi Tesisat ve Borular panelinde Boru aracini segin.

NEY=SEETE

Pipe Pipe Parallel @ Plumbing Sprinkler
Placeholder Pipes R  Fixture

Plumbing & Piping e

Secenekler Cubugunda, Cap parametresini 40mm ve Orta Yikseklik parametresini -
0.40m olarak degistirin.

Maodify | Place Pipe Diameter:|400mm  ~|  Middle Elevation:| -04000m

Kat planinda, fare imlecini dnceki resimde kirmizi daire icine alinmis alana yaklastirin ve
asagidaki resimde gosterildigi gibi, duvarin yaklasik yarisina kadar kiglk bir boru hatti
cizin.
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iki boru arasindaki mevcut baglantiyi silin, borunun ucunu yatay olarak tiklayin ve yeni
40mm boruyu karsilamak igin strtkleyin.

-0 ZOLO m
_

Cap duslrici (40 mm'den 15 mm'ye kadar) akuple olarak iki boru arasinda otomatik
olarak bir baglanti olusturulacaktir.

S— 1 [{ | R

Boruyu dikey yonde yeniden baglamak icin lzerine tiklayin ve daha 6nce baglanmis
olan boruyla bulusana kadar surikleyin.
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Bu alandaki baglantilar asagidaki resimdeki gibi goriinmelidir.

Simdi boruyu arazinin sinirina kadar suriklemelisiniz. Bunu yapmak igin, 3B goriinima
acin ve cizimi plan goériiniminde oldugu gibi yukaridan goériintiilemek icin gériinim
kipinde UST'e tiklayin. Aradaki fark, 3B gérinimde arazinin sinirlarini
gorsellestirmenin mimkin olmasidir.

Bununla, 40 mm'lik borunun ucuna tiklayin ve arazinin sinirina ulasana kadar c¢apraz
olarak sirtkleyin.
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Boruyu uzattiktan sonra Uzerine tiklayarak segin. Degistir | Kamu sebekesine baglanti
yerel su sirketi tarafindan yapildigindan, bu borunun baglantisiz ucunu kapatmak igin
Borular, Diizenle panelinde, Agik Uglari Kapat segenegini segin.

__ﬁ'_l
Cap
Open Ends

Asagidaki resim gibi gorinmelidir.

Tim ag yapilandirildiktan sonra, bazi bolimlerde c¢aplarda ve baglantilarda bazi
degisiklikler yapilmalidir. Asagidaki resimde ¢ap degisikligi gerektiren bolimler
belirtilmistir. Yesil kisimlar 40mm, sari kisimlar 25mm olarak degistirilmelidir. Digerleri
15 mm gapinda tutulmahdir.

L_ e |
e =
1N p—
i CEl=

Degisim cok basit bir sekilde yapilir. Sadece degistirilecek boruya tiklayin ve Cap
parametresindeki Secenekler Cubugunda (Boru Degistir) istediginiz degeri (25mm veya
40mm) secin.
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Maodify | Pipes Diameter: | 25.0 mm v ‘

Boru gapi degistirilirken baglanti ¢apinin da otomatik olarak degistirildigini dogrulamak
cok oOnemlidir. Degistiriimediyse baglantiya tiklayin ve Cap parametresindeki
Secgenekler Cubugunda (Boru Ek Pargalarini Degistir) istediginiz degeri (25mm veya
40mm) segin.

Madify | Pipe Fittings Diameter: | 25.0 mm w

5.6.3. Ek Agiklamalar

Boru capi tanimlayicilari gibi detaylandirma o6geleri eklemek icin Aciklama Ekle
sekmesine, Etiket paneline erisin ve Kategoriye Gore Etiketle aracini secin.

[

Tag by
Category

Arac seciliyken, fare imlecini tanimlanacak 6geye yaklastirin ve 6geye karsilik gelen
capla birlikte tanimlama metni goriinecektir. Metni istediginiz gibi konumlandirin ve
tanimlamayi eklemek icin 6geye tiklayin.

15 mmo

Pipes : Pipe Types : PVC - DWV L

Bu durumda metin, ¢izimin 6lgegi icin ¢ok blyuktir. Metin boyutunu degistirmek igin
metne cift tiklayin ve ardindan Degistir | Etiket. Segmek icin “Boyut” metnine bir kez
tiklayin.
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Size

Metin seciliyken, Ozellikler Paletinde Diizenleme Tiirii'ne tiklayin.

Properties X
Label -
2.5
Pipe Tags (1) ~ | B3 Edit Type
Graphics G
Sample Text Size...
Label | Edit...
Wrap between paramet... [_]
Horizontal Align Center
Vertical Align Middle
Keep Readable ]
Visible :

Properties help Apply

Metin Boyutu parametresinin 0,8 mm olarak diizenlenmesi gereken Tiir Ozellikleri
penceresi agilacaktir.

Type Properties x
Family: |System Family: Label b ‘ Load...
Type: |2.5 b ‘ Duplicate...
Rename...

Type Parameters

| Parameter | Value |=

Color . Black
Line Weight 1
Background Opaque
Show Border O
Leader/Border Offset 2.0320 mm

Text Font Avial

Text Size Mnm

Tab Size 12.5000 mm

Bold O

Italic ]

Underline O

Width Factor 1.000000
What do these properties do?

<< Preview | oK | | Cancel ‘ | Apply
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Metin boyutunu dizenledikten sonra, Aile Dizenleyici panelinde, Projeye Yiikle

simgesine tiklayin.
i
x| & | &g

Edit Jload into Load into
Label § Project JProject and Close

Label Family Editor

Ailenin zaten var oldugunu bildiren bir pencere agilacaktir. “Mevcut slirimin Gzerine
yaz” secenegine tiklayin.

Family Already Exists X

You are trying to load the family M_Pipe Size Tag, which
already exists in this project. What do you want to do?

—> Overwrite the existing version

—> Overwrite the existing version and its parameter
values

Cancelar

Click here to learn more

Metin artik daha uygun bir boyutta, gerekirse metni daha da biyiitmek veya kiciltmek
icin yeniden diizenleyebilirsiniz.

+
Metni temsil ettigi boruya siiriiklemek icin metnin *#" hemen altinda bulunan simgeye
tiklayin ve istediginiz yere strtkleyin.

15 mme

Asagidaki resimdeki gibi gériinmesi icin tiim borular icin ayni prosediri uygulayin.

157

*




Co-funded by the
V ET Erasmus+ Programme
of the European Union

3B BIM Modelleme

15 mma

15 mme 15 mme

(A — —1 |

Aciklama Ekle sekmesindeki TUmuni Etiketle aracini da kullanabilirsiniz.

[ @

Tag by | Tag
Category| All

Etiketlenmemis Tuminu Etiketle penceresinde, Kategori stitunundaki Boru Etiketleri
secenegini segin.

Tag All Not Tagged X
Select at least one Category and Tag or Symbol Family to annotate
non-annotated objects:

(@) All objects in current view

Only selected objects in current view
[ ]include elements from linked files

Category Loaded Tags &
[ |Mechanical Equipment Tags M_Mechanical Equipment Tag :
[ ] Nurse Call Device Tags M_Nurse Call Devices Tag
Pipe Tags M_Pipe Size Tag
[ ] Plumbing Fixture Tags M_Plumbing Fixture Tag : Boxe
[ ]Room Tags M_Room Tag : Room Tag
[ ] Security Device Tags M_Security Devices Tag
[ |Space Tags M_Space Tag : Space Tag
[ ]Sprinkler Tags M_Sprinklers Tag
[ | Telephone Device Tags M_Telephone Device Tag
I W2l Tance RA Wall Tam 1 7mmn ~
[ ILeader Leader Length: ~ 12.7 mim
Tag Orientation:
| 0K | ‘ Cancel ‘ ‘ Apply ‘ ‘ Help
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Tamam'a tiklanarak, projedeki mevcut tim borulara tanimlamalar eklenir. Ancak,
bircok metin Ust Uste gelir ve yine de manuel ayarlamalar yapiimalidir.

5.6.4. Cizelgeler Olusturun

Revit MEP icin tablolar olusturma, Revit Architecture ile ayni sekilde yapilir. Degisen,
her bir tablo tiriinde goériintiilenen bilgilerdir. Ornek olarak, borular hakkinda bilgi
iceren bir tablo olusturulacaktir.

Tablo olusturmaya baslamak icin Proje Tarayicisinda, Cizelgeler'de sag tiklayin ve
ardindan “Yeni Cizelge/Miktarlar” secenegini secin.

New Schedule/Quantities...

Properties help New Graphical Column Schedule...
New Material Takeoff...

New Sheet List...

Project Browser - MEP automati

El 3D Views . New Note Block...
- 3D Plumbin ) .
EI------EIevatiDns {Buil LEminer UEs
East - Pluml Browser Organization...
North - Plur Search..
South - Plur Expand All

o West - Plum
Collapse Selected

Collapse All

Space Qutdoor Air Schedule
—[EY Sheets (all)
-2 Families
[_]K'j] Groups

- Detail
- Model

L=
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Ardindan Yeni Zamanlama penceresinde, Kategori altinda Borular secenegini secin. Ad
boélimiinde tablonun adini degistirebilirsiniz. Bu durumda Boru Takvimi tutulacaktir.

New Schedule >

Filter list: | Piping v

Category: Name:

MEP Fabrication Hange... | Pipe Schedule
MEP Fabrication Pipew...
Model Groups

Parts

Pipe Accessaries (O schedule keys
Pipe Fittings

Pipe Insulations
Pipe Placehaolders

(@) Schedule building components

Phase:
Piping Systems
Plumbing Fixtures MNews Construction ™
Rooms
RVT Links hd
< >

Cizelge Ozellikleri penceresinde, Alanlar sekmesinde, tablo icin asagidaki parametreleri
segin: Baglanti Tipi, Cap, Akis, Uzunluk, Malzeme, Sistem Adi, En Yiiksek irtifa ve Hiz.
Schedule Properties X

Fields  Filter Sorting/Grouping Formatting Appearance

Select available fields from:

Fipes e

Available fields: Scheduled fields (in order):
~A| G |Connection Type
Assembly Code Diameter
Assembly Description Flow

Assembly Name Length

Bottom Elevation Material
Comments System Name
Cost Top Elevation
Count Velocity

Critical Path

Description

Family

Family and Type

Fixture Units L

Flows State |j

Friction

Friction Factor Fx

FeGUID

Image hd E

[Jinclude elements in links

Tamam'a tiklandiginda, secilen tiim bilgilerle tablo olusturulacaktir. Projede herhangi
bir degisiklik yapilirsa, tablo otomatik olarak gilincellenir ve bunun tersi de gecerlidir.
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<Pipe Schedule>
A B C D | E [ F G H
Connection Type Diameter Flow Length Material System Name Top Elevation Velocity
Generic 156.0 mm 09Ls 038m Polyvinyl Chloride - :Domestic Cold Water 10.22 m 4.8 mis
Generic 15.0 mm 00Ls 385m Polyvinyl Chloride - :Domestic Cold Water  -0.19 m 0.0 ms
Generic 15.0 mm 09 Lis 0.03m Polyvinyl Chloride - :Domestic Cold Water 0.27 m 4.8 mis
Generic 15.0 mm 0.9Lls 1.03m Polyvinyl Chloride - iDomestic Cold Water {0.87 m 4.8 mis
Generic 15.0 mm 0.9Lls 0.03m Polyvinyl Chloride - {Domestic Cold Water {0.93 m 4.8 mis
Generic 15.0 mm 09Ls 103m Polyvinyl Chloride - :Domestic Cold Water  0.87 m 48mis
Generic 15.0 mm 09Ls 0.03m Polyvinyl Chloride - :Domestic Cold Water 093 m 48 mis
Generic 15.0 mm 0.9Lls 0.04m Polyvinyl Chloride - iDomestic Cold Water [0.48 m 4.8 mis
Generic 15.0 mm 0.9Lls 0.04m Polyvinyl Chloride - iDomestic Cold Water {0.93 m 4.8 mis
Generic 15.0 mm 09Ls 103m Polyvinyl Chloride - :Domestic Cold Water  0.87 m 48mis
Generic 15.0 mm 09Ls 0.03m Polyvinyl Chloride - :Domestic Cold Water 093 m 48mis
Generic 15.0 mm 0.9Lls 150 m Polyvinyl Chloride - iDomestic Cold Water {2.36 m 4.8 mis
Generic 15.0 mm 0.9Lls 0.59m Polyvinyl Chloride - iDomestic Cold Water {0.43 m 4.8 mis
Generic 15.0 mm 09LUs 003m Polyvinyl Chloride - :Domestic Cold Water (048 m 48 mis
Generic 15.0 mm 09Ls 103m Polyvinyl Chloride - :Domestic Cold Water  0.87 m 48mis
Generic 15.0 mm 0.9L/s 0.03m Polyvinyl Chloride - {Domestic Cold Water {0.93 m 4.8 mis
Generic 40.0 mm 19LUs 14.02m Polyvinyl Chloride - {Domestic Cold Water |-0.18 m 1.5 mfs
Generic 15.0 mm 09Ls 0.06 m Polyvinyl Chloride - Domestic Cold Water [0.48 m 4.8 mis
Generic 15.0 mm 09Ls 0.07m Polyvinyl Chloride - :Domestic Cold Water 027 m 48mis
Generic 15.0 mm 0.9 Lis 0.04m Polyvinyl Chloride - ;Domestic Cold Water 0.82 m 4.8 mis
Generic 15.0 mm 0.9Lls 0.04m Polyvinyl Chloride - iDomestic Cold Water {0.82 m 4.8 mis
Generic 15.0 mm 09 Lis 176 m Polyvinyl Chloride - :Domestic Cold Water 082 m 4.8 mis
Generic 15.0 mm 09Ls 093m Polyvinyl Chloride - :Domestic Cold Water  0.77 m 48mis
Generic 15.0 mm 0.0 Lis 037m Polyvinyl Chloride - :Domestic Cold Water -0.19 m 0.0 m/s
Generic 15.0 mm 0.0LUs 0.38 m Polyvinyl Chloride - iDomestic Cold Water {0.22 m 0.0 m/s
Generic 15.0 mm 0.9Lls 0.15m Polyvinyl Chloride - iDomestic Cold Water {0.43 m 4.8 mis
Generic 15.0 mm 00Ls 304m Polyvinyl Chloride - :Domestic Cold Water 027 m 0.0 ms
Generic 15.0 mm 00Ls 049 m Polyvinyl Chloride - :Domestic Cold Water 027 m 0.0 ms
Generic 15.0 mm 0.9Lls 0.57m Polyvinyl Chloride - iDomestic Cold Water {0.87 m 4.8 mis
Generic 15.0 mm 0.0LUs 0.38 m Polyvinyl Chloride - iDomestic Cold Water {0.22 m 0.0 m/s
Generic 15.0 mm 09Ls 084 m Polyvinyl Chloride - :Domestic Cold Water 027 m 48mis
Generic 40.0 mm 00Ls 677 m Polyvinyl Chloride - :Domestic Cold Water  -0.38 m 0.0 ms

5.6.5. izometrik Goriiniimler Olusturun

Projenin daha iyi temsil edilmesi i¢in agin izometrik gériiniimleri olusturulabilir. Cizimi
izometrik bir goérinimde konumlandirmak igin, asagidaki resimde mavi alanda

ey

gosterildigi gibi 3B gortinim agin ve kiipln koselerinden birine tiklayin.

Agin genel bir izometrik goriniminid olusturmak icin 6nce 3B gorinimi ¢ogaltmaniz
gerekir. Bunu yapmak icin, Proje Tarayicisinda, 3B Tesisat goriinimuine sag tiklayin,
ardindan Cogalt Gériiniimii'ne ve ardindan Cogalt'a tiklayin. Gériinimi “izometrik
Tesisat” olarak yeniden adlandirin.
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M 3D View Open
Open Sheet
3D View: 3D Plumbing Close
Graphics Show Camera
View Scale @ Apply Template Properties...
Scale Value, '] 100 Create View Template From View...
Detail Level Medit .
Parts Visibility Show I DuplicateView

Visibility/Graphics Overr...

Graphic Display Options

Convert to independent view
Apply Dependent Views...
Save to Project as Image..

Discipline PIumE

Show Hidden Lines By Dis Delete
Pr io< hel Copy to Clipboard
Properties help

Project Browser - MEP automatict
4 HVAC

Rename...
Select All Instances
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Duplicate
Duplicate with Detailing
Duplicate as a Dependent

= Plumbing ~ Properties

—| - Floor Plans Save to New File...
1= Plumbing Search...
2,- PR Expand All

= 3D Views
Collapse All

= Elevations (Building Elevation)
East - Plumbing

North - Plumbing
South - Plumbing
West - Plumbing

Y A\ O\
\\\\

WY

Bu goériinimde seviyelere ihtiya¢ duyulmaz, bodylece onlari gizleyebilirsiniz. Bunu
yapmak icin, farenin sag tusu ile seviyelerden birine tiklayin, Goriinimde Gizle'ye
tiklayin ve Kategori secenegini secin.

Cancel

Repeat [Select links]
Recent Commands

Drag End
Go to Floor Plan
Maximize 3D Extents

Hide in View
Override Graphics in View

Create Similar

Edit Family

Select Previous
Select All Instances
Delete

Elements
Category
By Filter...

Asagidaki resme gore konumlanan izometri ile konum sabitlenecektir.
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€3

tiklamaniz ve Yoni Kaydet ve Gorinimu Kilitle segcenegini belirlemeniz yeterlidir. Bu

Konumu sabitlemek i¢in gorsellestirme cubugunda Kilitli 3B Gorinim simgesine

durumda gorinim dondirilemez.

ﬁ Save Orientation and Lock View

Restore Orientation and Lock View
Unlock View

&k G o iR B[GE]> o e @ila <

GOrinimin kirpma boélgesini tanimlamak énemlidir, bdylece yazdirma igin bir yapraga

eklendiginde zaten ayarlanmis olur. Bunu yapmak =0 icin gorsellestirme cubugunda
Kirpma Bolgesini Goster'e tiklayin.

%k GO BB ¢ i & IE <

Kirpma boélgesi olan dikdoértgen gorintilenecektir. Dikdortgenin Uzerine tiklayin ve
asagidaki resimde gosterildigi gibi ¢izimin sinirlarina ¢ok yakin olacak sekilde ayarlayin.
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Q

@]

R S
NN
\%g :

Kirpma bdlgesini ayarladiktan sonra, kirpma bdolgesini ARy gizlemek icin Onizleme
Cubugunda Kirpma Boélgesini Gizle secenegini secin.

FEI & &Gl o (i & IE <

Genel izometrik gorinim olusturulur. Simdi bir banyonun izometrik bir gorinimi
olusturulacak. Bunu yapmak icin, "izometrik Tesisat" gorinimini c¢ogaltin ve
"izometrik Tesisat Banyosu" olarak yeniden adlandirin.

“izometrik Tesisat Banyosu” goriinimi agikken, 3D Gériinimiin Kilidini A¢ simgesine
tiklayin ve 3D goérinlimin tekrar tasinmasina izin vermek i¢cin Gérlinimun Kilidini Ag
secenegini segin.

Save Orientation and Lock View

Restore Orientation and Lock View
B Unlock View
<

B 4x GG &R 5 o & i &
Asagidaki resimde gosterildigi gibi goriinime ulasana kadar 3B gorinimi

gorsellestirme kiplniin koseleri boyunca dondiriin. Konumlandirildiktan sonra, @
Kilitli 3D GoOrlinim simgesine tekrar tiklayin. Kirmizi daire, izometrik goériinimdin
olusturulacagi ortami temsil eder.
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izometrik gorinimi yalnizca istenen ortamdan kesmek icin Kesit Kutusu aracini
kullanabilirsiniz. Etkinlestirmek igin, gériinimiin Ozellikler Paletindeki Boélim Kutusu
secenegini isaretlemeniz yeterlidir.

Properties X
Qﬁ 3D View -
3D View: Isometric Plumbing v Edit Type
Scale Value 1T 100 ~
Detail Level Medium
Parts Visibility Show Original
Visibility/Graphics Overr... Edit...
Graphic Display Options Edit...
Discipline Plumbing
Show Hidden Lines By Discipline
Default Analysis Display... None
Sub-Discipline Plumbing
Sun Path ]
Extents 2
Crop View ]
Crop Region Visible ]
Annotation Crop ]
Far Clip Active ]
Far Clip Offset 304.8000 m
Scope Box None
Section Box
Camera B
Rendering Settings Edit... -
Properties help . APP.W.

Ardindan, yalnizca istediginiz ortami kirpmak icin ayarlayabileceginiz bir Se¢cim Kutusu
gorlinecektir.
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&>

%

(] .
Not: Onay Kutusu gérinmuyorsa, °  gorsellestirme cubugunda, Gizli Ogeleri Goster'e

tiklayin, ardindan goriinecektir.

AY
Va

AY

Secim Kutusunun oklarini kullanarak, asagidaki goriintliye benzer bir sonuc elde edene
kadar, Kutu sinirini tasimak istediginiz yone siriiklemeniz veya tiklamaniz gerekir.
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&

Secim Kutusunu gizlemek icin Gzerine sag tiklayin, Goriniimde Gizle'ye tiklayin ve
Ogeler secenegini secin.

Cancel

Repeat [Hide Elements]

Recent Commands >

Hide in View > Elements
Override Graphics in View > Category
Create Similar By Filter...
Edit Family

Select Previous

Select All Instances > P

Delete

Reset Crop Boundary to Model
Reset Crop Boundary to Screen

Find Referring Views

Zoom In Region
Zoom Out (2x)
Zoom To Fit

Previous Pan/Zoom
Next Pan/Zoom

Browsers > P

v Properties

Asagidaki resimde oldugu gibi izometrik goriiniimde sadece borularin ve baglantilarin
gorinmesini istiyorsaniz sithhi tesisat armaturleri (lavabo, klozet, dus) icin de aynisi
yapilabilir.
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5.6.6. E-Tablolar Olusturun

Baski icin sayfalarin olusturulmasi, mimari model egitiminde aciklanan prosedirle
tamamen ayni sekilde yapilir (bkz. Revit Architecture 6greticisinin 5.11 maddesi). Bu
durumda, ayni talimatlari izleyerek, bu 6greticide olusturulan iki plan gorinimu ve iki
izometrik gérinim{ iceren bir veya daha fazla sayfa olusturmalisiniz.
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